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1 Introduction 

The PCAN-USB Pro FD adapter enables the connection of CAN FD 
and LIN networks to a computer via USB. Two field busses can be 
connected at the same time, up to four with appropriate adapter 
cables (2 x CAN FD, 2 x LIN). Each CAN FD channel is separately 
isolated against USB and LIN with a maximum of 500 Volts. Its 
robust aluminum casing makes the PCAN-USB Pro FD adapter 
suitable for mobile applications. 

The new CAN FD standard (CAN with Flexible Data Rate) is prima-
rily characterized by higher bandwidth for data transfer. The maxi-
mum of 64 data bytes per CAN FD frame (instead of 8 so far) can be 
transmitted with bit rates up to 12 Mbit/s. CAN FD is downward-
compatible to the CAN 2.0 A/B standard, thus CAN FD nodes can be 
used in existing CAN networks. However, in this case the CAN FD 
extensions are not applicable. 

The monitor software PCAN-View and the programming interface 
PCAN-Basic for the development of applications with CAN 
connection are included in the scope of supply and support the new 
standard CAN FD. 

The monitor application PLIN-View Pro as well as the PLIN 
programming interface are included in the scope of supply. 

Device drivers exist for different operating systems, so programs 
can easily access a connected CAN and/or LIN bus. 

Tip: At the end of this manual (Appendix C) you can find a 
Quick Reference with brief information about the installation 
and operation of the PCAN-USB Pro FD adapter. 
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1.1 Properties at a Glance 

 Adapter for High-speed USB 2.0  
(compatible to USB 1.1 and USB 3.0) 

 Transmitting and receiving of CAN FD and LIN messages using 
2 D-Sub connections (both with pin assignment for CAN FD and  
LIN bus) 

 Time stamp resolution 1 μs 

 5-Volt supply at the D-Sub connector can be activated through a 
solder jumper, e.g. for external bus converter 

 Voltage supply via USB 

 Extended operating temperature range -40 - 85 °C (-40 - 185 °F) 

CAN operation properties 

 Complies with CAN specifications 2.0A/B and FD 

 CAN FD support for ISO and Non-ISO standard switchable 

 CAN FD bit rates for the data field (64 bytes max.) from 25 kbit/s 
up to 12 Mbit/s 

 CAN bit rates from 25 kbit/s up to 1 Mbit/s 

 FPGA implementation of the CAN FD controller 

 NXP TJA1044GT CAN transceiver 

 Each CAN FD channel is separately opto-decoupled against USB 
and LIN up to 500 V 

 CAN termination can be activated through a solder jumper, 
separately for each CAN channel 

 Measurements of bus load including error frames and overload 
frames on the physical bus 

 Induced error generation for incoming and outgoing CAN 
messages 
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LIN operation properties 

 Bit rates from 1 up to 20 kbit/s 

 TJA1021/20 LIN transceiver 

 Both LIN channels (common ground) are opto-decoupled 
against USB and CAN FD 

 Can be used as a LIN master or slave (1 ms master task 
resolution) 

 Automatic bit rate, frame length, and checksum type recognition 

 Autonomous scheduler with support for unconditional, event, 
and sporadic frames 

 Hardware can work through a schedule table (up to 8 tables can 
be configured with a total of 256 slots) 

Note: This manual describes the use of the PCAN-USB Pro FD 
with Windows. You can find CAN drivers for Linux and the 
corresponding application information on the provided DVD in 
the directory branch Develop and on our website under 
www.peak-system.com/linux. 

1.2 System Requirements 

 Operating system Windows 10, 8.1, 7 (32/64-bit)  
or Linux (32/64-bit) 

 A vacant USB port (USB 1.1, USB 2.0 or USB 3.0 ) at the 
computer or at a USB hub connected to the computer 

 For LIN operation: supply voltage 8 to 18 V for the LIN 
transceiver (e.g. car battery) 

http://www.peak-system.com/linux�
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Note: Do not use a USB extension cable to connect the PCAN-
USB Pro FD adapter to the computer. The use of an extension 
cable does not comply with the USB specification and can lead 
to malfunction of the adapter. 

1.3 Scope of Supply 

 PCAN-USB Pro FD in aluminum casing 

 CAN FD interface drivers for Windows 10, 8.1, 7 
and Linux (32/64-bit) 

 LIN interface drivers for Windows 10, 8.1, 7 (32/64-bit) 

 CAN monitor PCAN-View for Windows 

 LIN monitor PLIN-View Pro for Windows 

 Programming interface PCAN-Basic for developing applications 
with CAN connection 

 Programming interface PLIN-API for developing applications 
with LIN connection 

 Programming interfaces for standardized protocols from the 
automotive sector 

 Manual in PDF format 

Note: Since the application possibilities of the PCAN-USB Pro 
FD adapter are various, special cable adapters for connecting 
the CAN and LIN busses are not provided. Therefore you need 
a 9-pin D-Sub female connector for your appliances to be 
connected individually. 
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2 Installing the Software and 
the Adapter 

This chapter covers the software setup for the PCAN-USB Pro FD 
adapter under Windows and the connection of the adapter to a 
computer. 

Install the driver before you connect the adapter to the computer. 

Do the following to install the drivers: 

1. Start Intro.exe from the supplied DVD. 

The navigation program starts. 

2. Select in the main menu Drivers and click on Install now. 

3. Confirm the message of the User Account Control related to 
"Installer database of PEAK Drivers". 

The driver setup starts. 

4. Follow the instructions of the program. When getting to the 
components selection, add the LIN Driver. 

Do the following to connect the adapter: 

Note: Do not use a USB extension cable to connect the PCAN-
USB Pro FD adapter to the computer. The use of an extension 
cable does not comply with the USB specification and can lead 
to malfunction of the adapter. 

1. Connect the adapter to a USB port at the computer. The 
computer can remain powered on. 

Windows detects the new hardware and completes the 
driver installation. 

2. Check the LEDs on the adapter. If the LEDs are green, then 
the driver was initialized successfully. 
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3 Connecting the CAN and LIN 
Bus 

Both D-Sub connectors on the PCAN-USB Pro FD adapter are each 
used for connecting one CAN and one LIN bus. The pin assignment 
is identical for both D-Sub connectors. 

Note: Since the application possibilities of the PCAN-USB Pro 
FD adapter are various, special cable adapters for connecting 
the CAN and LIN busses are not provided. Therefore you need 
a 9-pin D-Sub female connector for your appliances to be 
connected individually. 

3.1 CAN Connection over D-Sub Connector 

Two High-speed CAN busses (ISO 11898-2) can be connected, one 
to each D-Sub connector. The pin assignment for CAN corresponds 
to the specification CiA® 303-1. 

 
Figure 1: CAN pin assignment of the D-Sub connector 

With the pin 1 devices with low power consumption (e.g. bus 
converters) can be directly supplied via the CAN connector. At 
delivery these pin are not assigned. You can find a detailed 
description about the activation in the following section 3.3. 
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Each CAN connection separately has a galvanic isolation up to 
500 V against USB and LIN. 

Tip: You can connect a CAN bus with a different transmission 
standard via a bus converter. PEAK-System offers different bus 
converter modules (e.g. PCAN-TJA1054 for a Low-speed CAN 
bus according to ISO 11898-3). 

3.2 LIN Connection over D-Sub Connector 

Two LIN busses can be connected, one to each D-Sub connector. 

 
Figure 2: LIN pin assignment of the D-Sub connector 

For the LIN operation an additional supply voltage must be applied 
to pin Vbat-LIN (8 - 18 V DC, e.g. car battery). Both LIN connections 
need their own supply. 

Both LIN connections have a common galvanic isolation up to 500 V 
against USB and CAN. The LIN connections are not galvanically 
isolated against each other. 
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3.3 Voltage Supply of External Devices 

External devices with low power consumption (e.g. bus converters) 
can be directly supplied via the CAN connector. With a solder bridge 
per CAN channel on the PCAN-USB Pro FD board (casing opened), a 
5-Volt supply can optionally be routed to pin 1 of the D-Sub 
connector. The current output is limited to 50 mA. 

 
Figure 3: External 5-Volt supply at the D-Sub connectors 

Tip: On request we deliver the device configured with this 
option. 

Do the following to activate the voltage supply: 

Risk of short circuit! Solder with great care to avoid unwanted 
short circuits on the card. 

Attention! Electrostatic discharge (ESD) can damage or destroy 
components on the card. Take precautions to avoid ESD. 

1. Remove the three screws at the back of the casing. 

 
Figure 4: Attachment points at the back side of the casing 
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2. Remove the two outer screws next to the D-Sub connectors 
at the front of the casing. 

 
Figure 5: Attachment points of the D-Sub connectors 

 at the front side of the casing 

3. Remove the casing cover. 

4. Lift the back of the case and slide the circuit board in 
direction of the front over the lower part of the casing. The 
bottom of the circuit board is accessible now. 

5. Set the solder bridges on the circuit board of the adapter to 
activate the termination. 

Figure 6 shows the positions of the solder fields for the 
termination. 

6. Reassemble the device. Slide the circuit board back into the 
lower part of the casing. 

7. Close the casing cover. 

8. Screw the front and back side (Figure 4 and Figure 5). 
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Figure 6: Top view PCAN-USB Pro FD board,  

solder fields JP4/JP7 

5-Volt supply 
D-Sub 

connector 
Solder 
field Without 

(standard) 
With 

(Pin 1) 

CAN1 JP4   

CAN2 JP7   
 

Risk of short circuit! The 5-Volt supply is not protected 
separately. Therefore, turn off the computer before you connect 
and disconnect CAN cables or peripheral systems. 

Consider that some computers still supply the USB ports with 
power even when they are turned off (standby operation). 
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3.4 Activating the Internal CAN 
Termination 

The termination can be activated by solder jumpers for each 
channel on the board. At delivery the termination is not activated. 
A High-speed CAN bus (ISO 11898-2) must be terminated on both 
ends with 120 Ohms. Otherwise disturbances may arise. If a CAN 
bus is not terminated correctly, activate the internal termination. 

Do the following to activate the internal termination: 

Risk of short circuit! Solder with great care to avoid unwanted 
short circuits on the card. 

Attention! Electrostatic discharge (ESD) can damage or destroy 
components on the card. Take precautions to avoid ESD. 

1. Remove the three screws at the back of the casing. 

 
Figure 7: Attachment points at the back side of the casing 

2. Remove the two outer screws next to the D-Sub connectors 
at the front of the casing. 

 
Figure 8: Attachment points of the D-Sub connectors 

 at the front side of the casing 

3. Remove the casing cover. 
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4. Lift the back of the case and slide the circuit board in 
direction of the front over the lower part of the casing. The 
bottom of the circuit board is accessible now. 

5. Set the solder bridges on the circuit board of the adapter to 
activate the internal termination. 

Figure 9 shows the positions of the solder fields for the 
termination. 

6. Reassemble the device. Slide the circuit board back into the 
lower part of the casing. 

7. Close the casing cover. 

8. Screw the front and back side (Figure 7and Figure 8). 
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Figure 9: Top view PCAN-USB Pro FD board,  

solder fields JP1/JP2 and JP5/JP6 

Internal termination 
D-Sub 

connector 
Solder 
fields Without 

(standard) 
Active 

CAN1 
JP2 and 

JP3   

CAN2 
JP5 and 

JP6   
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3.5 Cabling 

3.5.1 Termination 

The High-speed CAN bus (ISO 11898-2) must be terminated with 
120 ohms at both ends. The termination prevents interfering signal 
reflections and ensures the proper operation of the transceiver of 
the connected CAN nodes (CAN interface, control device). 

The PCAN-USB Pro FD adapter has an internal termination. For 
more information, see chapter 3.4. 

3.5.2 Example of a Connection 

 
Figure 10: Simple CAN connection 

In this example, the PCAN-USB Pro FD adapter is connected with a 
control unit by a cable that is terminated with 120 ohms at both 
ends. 
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3.5.3 Maximum Bus Length 

High-Speed-CAN networks may have bit rates of up to 1 Mbit/s. The 
maximum bus length depends primarily on the bit rate. 

The following table shows the maximum possible CAN bus length 
at different bit rates: 

Bit rate Bus length 

1 Mbit/s 40 m 

500 kbit/s 110 m 

250 kbit/s 240 m 

125 kbit/s 500 m 

50 kbit/s 1.3 km 

25 kbit/s 2.5 km 
 

The listed values have been calculated on the basis of an idealized 
system and can differ from reality. 

Note: For CAN FD, the same maximum bus lengths apply as for 
CAN, despite the higher data bit rate of CAN FD. 
The dependency is based on the bit rate during the arbitration, 
called nominal bit rate. The nominal bite rate at CAN FD can be 
up to 1 Mbit/s. 
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4 Operation 

4.1 Status LEDs 

For indication of operating conditions the PCAN-USB Pro FD 
adapter has several LEDs. 

 
Figure 11: Layout of the LEDs on the casing 

LED Status Meaning 

Green on A High-speed USB connection (USB 2.0) with a 
computer is established. 

Green blinking Communication is occurring on the High-speed 
USB connection (USB 2.0). 

A Full-speed USB connection (USB 1.1) with a 
computer is established. 

Orange on 

The PCAN-USB Pro FD adapter is in suspend 
mode (only voltage supply via USB cable, e.g. 
during computer standby). 

USB 

Orange blinking Communication is occurring on the Full-speed 
USB connection (USB 1.1). 
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LED Status Meaning 

Green on The CAN interface is initialized. There's a 
connection to a driver of the operating system. 

Green slow blinking A software application is connected to the CAN 
interface. 

Green quick blinking Data is transmitted via the connected CAN bus. 

CAN1/2 

Red quick blinking An error is occurring during the transmission of 
CAN data, e.g. OVERRUN or BUSHEAVY. 

Green on There's a connection to a driver of the 
operating system. 

Green slow blinking The LIN interface is initialized with a valid bit 
rate. A software application is connected to the 
LIN interface. 

LIN1/2 

Green quick blinking Data is transmitted via the connected LIN bus. 
 

4.2 Unplugging the USB Connection 

On Windows, the icon for removing hardware safely is not used 
with the PCAN-USB Pro FD adapter. You may unplug the adapter 
from the computer without any preparation. 

4.3 Distinguishing Several PCAN-USB Pro FD 
Adapters 

You can operate several PCAN-USB Pro FD adapters on a single 
computer at the same time. The supplied program PCAN-View 
allows the assignment of device IDs in order to distinguish the 
adapters in a software environment. For more information, see 
section 5.1.3. 
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5 Software and API 

This chapter covers the provided software PCAN-View and PLIN-
View Pro and the programming interfaces PCAN-Basic and the 
PLIN-API. 

5.1 Monitor Software PCAN-View 

PCAN-View is simple Windows software for viewing, transmitting, 
and logging CAN and CAN FD messages. 

Note: This chapter describes the use of PCAN-View with a 
CAN FD adapter. 

 
Figure 12: PCAN-View for Windows 
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Do the following to start and initialize PCAN-View: 

1. Open the Windows Start menu and select PCAN-View. 

The Connect dialog box appears. 

 
Figure 13: Selection of the specific hardware and parameters 

2. Select an interface from the list. 

3. From the drop-down menu, choose a Clock Frequency. The 
selectable bit rates in the following are based on this 
setting. 

4. From the drop-down list, select a Nominal Bit rate, which is 
used for the arbitration phase (max. 1Mbit/s). 

5. Enable the Data Bit rate checkbox. 

6. From the drop-down menu, choose an additional 
Data Bit rate for the CAN FD bus. The bit rate selected here 
is used to transfer the data fields of a CAN FD frame with a 
higher bit rate. 

Note: Both transmission rates must match those which are 
used by all nodes on the CAN bus. 
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Tip: You can create custom bit rates by using the button (). 

7. Under Filter settings you can limit the range of CAN IDs to 
be received, either for standard frames (11-bit IDs) or for 
extended frames (29-bit IDs). 

8. Activate the Listen-only mode if you do not actively take 
part in the CAN traffic and just want to observe. This also 
avoids an unintended disruption of an unknown CAN 
environment (e.g. due to different bit rates). 

9. Confirm the settings in the dialog box with OK. The main 
window of PCAN-View appears (see Figure 14). 
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5.1.1 Receive/Transmit Tab 

 
Figure 14: Receive/Transmit tab 

The Receive/Transmit tab is the main element of PCAN-View. It 
contains two lists, one for received messages and one for the 
transmit messages. The CAN data format is hexadecimal by default. 

Do the following to transmit a CAN FD message: 

1. Select the menu command Transmit > New Message 
(alternatively  or  Ins ). 

The dialog box New Transmit Message appears. 

 
Figure 15: Dialog box new transmit message 
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2. Enable the CAN FD checkbox to define a CAN FD message 
with a maximum Length of 64 data bytes. 

3. Enter the ID, the data Length, and the CAN message Data. 
With a length of more than 8 bytes, click on  and enter the 
data bytes into the editor. 

Note: With the program version 4 of PCAN-View, the DLC field 
was renamed to Length. Latter reflects the actual data length. 

4. Enter a value into the Cycle Time field to choose manually 
or periodically message transmission. Enter a value greater 
than 0 to transmit periodically. Enter the value 0 to transmit 
only manually. 

5. Enable the Bit Rate Switch checkbox, that the data of a CAN 
FD message is transmitted with the selected Data Bit rate. 

6. Confirm the entries with OK. 

The created transmit message appears on the 
Receive/Transmit tab. 

7. Trigger selected transmit messages manually with the menu 
command Transmit > Send (alternatively  Space  bar). The 
manual transmission for CAN messages being transmitted 
periodically is carried out additionally. 

Tip: Under the menu command File > Save, you can save the 
current transmit messages into a transmit list. Saved transmit 
lists are available for reuse. 
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5.1.2 Trace Tab 

 
Figure 16: Trace tab 

On the Trace tab, the data tracer (data logger) of PCAN-View is used 
for logging the communication on a CAN bus. During this process 
the messages are cached in the working memory of the PC. 
Afterwards they can be saved to a file. 

The Tracer runs either in linear or in ring buffer mode. The linear 
buffer mode stops the Tracer as soon as the buffer is full. The ring 
buffer mode overwrites the oldest messages by new ones as soon 
as the buffer is full. 
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5.1.3 PCAN-USB Pro FD Tab 

 
Figure 17: PCAN-USB Pro FD tab 

The PCAN-PCI Express FD tab contains some detailed information 
about the hardware and driver. In addition, you can assign a Device 
ID to the adapter. Thus, it can be uniquely identified while operating 
several PCAN-USB Pro FD adapters on a computer at the same 
time. 

To identify a PCAN-USB Pro FD adapter, you first go to the dialog 
box for selecting the hardware of PCAN-View (Figure 13 on page 
23). In the list “Available PCAN hardware and PCAN-nets”, you can 
perform a right-click on every USB adapter and execute the 
command "identify". Thereby the LED of the corresponding adapter 
flashes shortly. 

CAN FD ISO-mode 

The defined in the ISO 11898-standard is not compatible with the 
original protocol. PEAK-System takes this into account by 
supporting both protocol versions with their CAN FD interfaces. 
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If required, the user can switch to the CAN FD protocol used in the 
environment with the Enable / Disable button („Non-ISO“ and 
„ISO“). 

5.1.4 Bus Load Tab 

 
Figure 18: Bus Load tab 

On the Bus Load tab, the current bus load, time course, and 
statistical information of the CAN channel are displayed. The CAN 
bus load reflects the utilization of transmission capacity. 
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5.1.5 Error Generator Tab 

 
Figure 19: Error Generator tab 

Via the Error Generator tab, the communication on the CAN bus can 
be disturbed for testing purpose by 6 consecutive dominant bits. 
This is a violation of the CAN protocol on the CAN bus which must 
be recognized as an error by the connected CAN nodes. 

You can destroy CAN frames with the error generator by one of two 
methods: 

 once after activation 

 repeatedly at specific intervals related to a CAN ID 

The Destroy Single Frame area refers to the next CAN frame that is 
recognized by the PCAN-USB Pro FD adapter after activation. 

Do the following to destroy a single CAN frame: 

1. Enter the Bit-Position where in the CAN frame the error is to 
be generated. The count includes the stuff bits. 

2. Execute the destroy action with Do it. 
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The next received or transmitted CAN frame will be des-
troyed at the selected bit position. 

The Destroy Multiple Frames area refers to a CAN ID whose frames 
are to be destroyed in specific intervals. 

Do the following to destroy multiple CAN frames: 

1. Enter the CAN ID of the frame to be destroyed. 

2. Enter the Bit-Position where in the CAN frame the error is to 
be generated. The count includes the stuff bits. 

3. The Number of Frames to ignore field specifies the number 
of CAN frames with the given ID that are ignored before a 
frame is destroyed. 

4. The Number of Frames to destroy field specifies the number 
of CAN frames with the given ID that are destroyed 
consecutively. 

5. Confirm the entries with Apply to activate the error gene-
rator.  

6. Stop destroying further CAN frames with Disable. 

5.1.6 Status Bar 

 
Figure 20: Display of the status bar 

The status bar shows information about the current CAN 
connection, about error counters (Overruns, QXmtFull) and shows 
error messages. 

You can find further information about the use of PCAN-View in the 
help which you can invoke in the program via the Help menu or 
with the  F1  key. 
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5.2 LIN Monitor PLIN-View Pro for Windows 

PLIN-View for Windows is a simple LIN monitor for receiving and 
transmitting LIN messages. 

 
Figure 21: PLIN-View Pro for Windows 

Note: PLIN-View Pro is provided exclusively for the use with the 
PCAN-USB Pro (FD). 

Do the following to start and initialize PLIN-View Pro: 

1. Start the program PLIN-View Pro from the Windows Start 
Menu All Programs > PEAK-Drivers and then PLIN-View Pro. 

The dialog box for selecting the LIN hardware and for 
setting the LIN parameters appears. 
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Figure 22: Selection of the LIN specific hardware and parameters 

2. From the Hardware list, select the LIN channel to be used. 

3. From the dropdown list Mode, select the operation mode 
Master or Slave to be used for the LIN channel. 

4. Select the bit rate that is used by all nodes on the LIN bus 
from the dropdown list Bit rate. 

5. If you do not know the bit rate for the connected LIN bus, 
you can automatically detect the used bit rate with the 
function Bit rate detection. In the field Timeout you can set 
the time, to wait for a response from the hardware until the 
timeout occurs. Confirm with Detect. 

Note: The LIN channel where the Bit rate detection is to be 
executed must not be initialized (no connection to a software). 

If a bit rate was determined successfully, it automatically 
appears in the dropdown list Bit rate. 

6. Confirm the settings in the dialog box with OK. The main 
window of PLIN-View Pro appears (see Figure 23). 
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5.2.1 Receive/Transmit or Receive/Publisher Tab 

 
Figure 23: Receive/Transmit tab 

The Receive/Transmit or Receive/Publisher tab is the main element 
of PLIN-View Pro. It contains two lists, one for received and one for 
transmitted LIN frames. 

If you are logged in as LIN-Master, the Receive/Transmit tab 
appears. In Master mode you can transmit frames on the LIN bus.  

If you are logged in as LIN-Slave, the Receive/Publisher tab appears. 
In Slave mode you cannot transmit frames. If the Master requests 
data from a Slave, he can publish it in the LIN frame. 

In the Global Frame Table all defined LIN frame entries are stored 
that can be set with the PCAN-USB Pro FD. To transmit a LIN frame 
you have to adjust the underlying frame definition in the properties. 
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Do the following to transmit a LIN frame with PLIN-View Pro: 

1. Select a frame from the Global Frame Table. 

2. Change the property Checksum Type to Enhanced or 
Classic. 

3. Change the property Direction in Publisher. 

4. Select the menu command Transmit > New Frame 
(alternatively ). 

The dialog box New frame appears. 

 
Figure 24: Dialog box New frame 

5. Select the frame that should be transmitted from the 
dropdown list ID. 

6. Enter in the field Data the data for the LIN frame. 

7. Confirm the entries with OK. 

8. Send the selected frame with the menu command Transmit 
> Send (alternatively  Space  bar). 
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Note: You can also manage and perform Schedule Tables. Fur-
thermore you can open LDF files and manage Schedule Tables 
with their information. The Schedule Tables are used to vali-
date or edit data and to present it symbolically. 

 

Tip: You can use PLIN projects to simplify the work with the 
Global Frame Table, the Transmit or Publisher list, the 
Schedule tables, and the LDF files. With the menu command 
File > Save all files and configurations are saved in such a 
project for later use. 

5.2.2 Trace Tab 

 
Figure 25: Trace tab 

On the Trace tab the data tracer of PLIN-View Pro is used for 
logging and presenting the communication of a LIN bus. 

At the start of the tracer the dialog box Save is shown. Enter a 
filename under which the recording should be stored. The storage 
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of data is done continuously until the tracer is stopped or the 
storage space on the selected medium is no longer sufficient. 

On the upper part of the tracer is a line that issues various 
information about the tracer status: the current status of the LIN 
tracer, the complete duration that the tracer is running and 
recording, the number of recorded LIN frames, and the file name 
under which the recording will be saved. 

5.2.3 Status Bar 

 
Figure 26: Display of the Status bar 

The status bar shows information about the current LIN hardware, 
the connected LIN channel, the used operation mode, the status of 
the LIN bus (Active/Sleep), and a counter of not transmitted or 
received LIN frames (Overruns). 

You can find further information about the use of PLIN-View Pro in 
the help which you can invoke in the program via the Help menu or 
the  F1  key. 
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5.3 Linking Own Programs with PCAN-Basic 
Version 4 or Higher 

 
Figure 27: PCAN-Basic 

On the provided DVD, you can find files of the programming inter-
face PCAN-Basic in the directory branch Develop. This API provides 
basic functions for linking own programs to CAN and CAN FD 
interfaces by PEAK-System and can be used for the following 
operating systems: 

 Windows 10, 8.1, 7(32/64-bit) 

 Windows CE 6.x (x86/ARMv4) 

 Linux (32/64-bit) 
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The API is designed for cross-platform use. Therefore software pro-
jects can easily ported between platforms with low efforts. For all 
common programming languages examples are available. 

Beginning with version 4, PCAN-Basic supports the new CAN FD 
standard (CAN with Flexible Data Rate) which is primarily 
characterized by higher bandwidth for data transfer. 

5.3.1 Features of PCAN-Basic 

 API for developing applications with CAN and CAN FD 
connection 

 Access to the CAN channels of a PCAN-Gateway via the new 
PCAN-LAN device type 

 Supports the operating systems Windows 10, 8.1, 7 (32/64-bit), 
Windows CE 6.x, and Linux (32/64-bit)  

 Multiple PEAK-System applications and your own can be 
operated on a physical channel at the same time 

 Use of a single DLL for all supported hardware types 

 Use of up to 16 channels for each hardware unit (depending on 
the PEAK CAN interface used) 

 Simple switching between the channels of a PEAK CAN interface 

 Driver-internal buffer for 32,768 messages per CAN channel 

 Precision of time stamps on received messages up to 1 μs 
(depending on the PEAK CAN interface used) 

 Supports PEAK-System‘s trace formats version 1.1 and 2.0 (for 
CAN FD applications) 

 Access to specific hardware parameters, such as listen-only 
mode 

 Notification of the application through Windows events when a 
message is received 
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 Extended system for debugging operations 

 Multilingual debugging output 

 Output language depends on operating systems 

 Debugging information can be defined individually 

 Thread-safe API 

Tip: An overview of the API functions is located in the header 
files. You can find detailed information about the PCAN-Basic 
API on the provided DVD in the text and help files (file name 
extensions .txt and .chm). 

5.3.2 Principle Description of the API 

The PCAN-Basic API is the interface between the user application 
and device driver. In Windows operating systems this is a DLL 
(Dynamic Link Library). 

The sequence of accessing the CAN interface is divided into three 
phases: 

1. Initialization 

2. Interaction 

3. Completion 

Initialization 

A channel must be initialized before using it. This is done by the 
simple call of the function CAN_Initialize for CAN and 
CAN_InitializeFD for CAN FD. Depending on the type of the CAN 
hardware, up to 16 CAN channels can be opened at the same time. 
After a successful initialization the CAN channel is ready. No further 
configuration steps are required. 
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Interaction 

For receiving and transmitting messages, the functions CAN_Read and 
CAN_Write as well as CAN_ReadFD and CAN_WriteFD are available. 
Additional settings can be made, e.g. setting up message filters for 
specific CAN IDs or the listen-only mode for the CAN controller. 

When receiving CAN messages, events are used for an automatic 
notification of an application (client). This offers the following 
advantages: 

 The application no longer needs to check for received messages 
periodically (no polling). 

 The response time at reception is reduced. 

Completion 

To end the communication the function CAN_Uninitialize is called in 
order to release the reserved resources for the CAN channel, among 
others. In addition the CAN channel is marked as "Free" and is 
available to other applications. 

5.3.3 Notes about the License 

Device drivers, the interface DLL, and further files needed for linking 
are property of the PEAK-System Technik GmbH and may be used 
only in connection with a hardware component purchased from 
PEAK-System or one of its partners. If a CAN hardware component 
of third-party suppliers should be compatible to one of PEAK-
System, then you are not allowed to use or to pass on the driver 
software of PEAK-System. 

If a third-party supplier develops software based on the PCAN-Basic 
and problems occur during the use of this software, consult the 
software provider. 
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5.4 Linking Own Programs with the PLIN-API 

 
Figure 28: PLIN-API 

On the provided DVD, you can find files to develop Windows 
software with an interface to a LIN bus in the directory branch  
Develop/PC interfaces/Windows/PLIN-API. 

Note: PLIN-API is provided exclusively for the use with the 
PCAN-USB Pro (FD). 

Furthermore, the DVD contains header files and a programming 
example for creating own applications in conjunction with the 
PLIN-API. Read the detailed documentation of the interface (API) in 
the corresponding header file. 
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Note: You can find further information in the text and help files 
(file name extensions .txt and .chm). 

Notes about the License 

Device drivers, the PLIN interface DLL, and further files needed for 
linking are property of the PEAK-System Technik GmbH and may be 
used only in connection with a hardware component purchased 
from PEAK-System or one of its partners. If a LIN hardware compo-
nent of third-party suppliers should be compatible to one of PEAK-
System, then you are not allowed to use or to pass on the driver 
software of PEAK-System. 

If a third-party supplier develops software based on the PLIN-API 
and problems occur during use of this software, consult the soft-
ware provider. 



PCAN-USB Pro FD – User Manual 
 

44 

6 Technical Specifications 

Connectors  

USB USB plug type A 

CAN/LIN 
 

D-Sub (m), 9 pins 
Pin assignment according to specification CiA® 303-1 

 

USB  

Type High-speed USB 2.0 (compatible with USB 1.1  
and USB 3.0) 

 

CAN  

Protocols CAN FD ISO 11898-1:2015, CAN FD non-ISO, 
CAN 2.0 A/B 

Physical transmission ISO 11898-2 (High-speed CAN) 

CAN bit rates 25 kbit/s - 1 Mbit/s 

CAN FD bit rates 25 kbit/s - 12 Mbit/s 

Controller FPGA implementation 

Timestamp resolution 1 μs 

Transceiver TJA1044GT 

Internal termination Not activated, switchable by solder jumper 

Galvanic isolation Up to 500 V 
The CAN connections are isolated separately. 

Supplying external 
devices 

D-Sub Pin 1; 5 V, max. 50 mA 
Not assigned at delivery 

 

LIN  

Bit rates 1 kbit/s - 20 kbit/s 

Specification LIN specification 2.1 

Timestamp resolution 1 μs 

Transceiver TJA1021/20 

Galvanic isolation Up to 500 V 
The LIN connections have a common ground. 

 

Continued on the next page 
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Power supply  

Supply voltage 5 V DC via USB port 
LIN operation: 8 - 18 V DC via D-Sub connector 

Power consumption max. 200 mA at 5 V via USB 
 

Environment  

Operating temperature -40 - 85 °C (-40 - 185 °F) 

Temperature for storage 
and transport 

-40 - 100 °C (-40 - 212 °F) 

Relative humidity 15 - 90 %, not condensing 

EMC Directive 2014/30/EU 
DIN EN 55024:2016-05 
DIN EN 55022:2011-12 

Ingress protection 
(IEC 60529) 

IP20 

 

Measures  

Size 71.5 x 24 x 114 mm (W x H x D) (without connection 
cable) 

See also dimension drawings in Appendix B on page 47 

Cable length ca. 1.5 m 

Weight 220 g (with USB cable) 
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Appendix A CE Certificate 
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Appendix B Dimension Drawing 

 
Figure 29: Top view of housing 

The figure doesn’t show the actual size of the product. 
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Appendix C Quick Reference 

Software/Hardware Installation under Windows 

Install the driver from the supplied DVD, before you connect the 
PCAN-USB Pro FD to the computer. After that, you connect the 
adapter to a USB port of the computer or of a connected USB hub. 
The computer can remain powered on. The LEDs must light green. 

Note: Do not use a USB extension cable to connect the PCAN-
USB Pro FD to the computer. 

Getting Started under Windows 

Run the CAN monitor PCAN-View or the LIN monitor PLIN-View Pro 
from the Windows Start menu as sample applications for accessing 
the PCAN-USB Pro FD adapter. For initialization of the CAN interface 
select the CAN channel and the bit rate. For initialization of the LIN 
interface select the LIN channel, the operation mode (Master or 
Slave), and the bit rate. 

LED Status Meaning 

Green on A High-speed USB connection (USB 2.0) with a 
computer is established. 

Green blinking Communication is occurring on the High-speed 
USB connection (USB 2.0). 

A Full-speed USB connection (USB 1.1) with a 
computer is established. 

Orange on 

The PCAN-USB Pro FD adapter is in suspend 
mode (only voltage supply via USB cable, e.g. 
during computer standby). 

USB 

Orange blinking Communication is occurring on the Full-speed 
USB connection (USB 1.1). 
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LED Status Meaning 

Green on The CAN interface is initialized. There's a 
connection to a driver of the operating system. 

Green slow blinking A software application is connected to the CAN 
interface. 

Green quick blinking Data is transmitted via the connected CAN bus. 

CAN1/2 

Red quick blinking An error is occurring during the transmission of 
CAN data, e.g. OVERRUN or BUSHEAVY. 

Green on There's a connection to a driver of the 
operating system. 

Green slow blinking The LIN interface is initialized with a valid bit 
rate. A software application is connected to the 
LIN interface. 

LIN1/2 

Green quick blinking Data is transmitted via the connected LIN bus. 
 

D-Sub connector (9 pins) for CAN/LIN 
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